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1 Introduction
The Transmission control system gives laptop tunable electronic control over shift points, convertor lockup and 
line pressure. Integration with Megasquirt and Microsquirt ECUs using CAN is available to reduce wiring by 
sharing sensors.

The application is primarily targetted at the Microsquirt hardware, but may also be implemented on GPIO or 
MS2. This is the core manual and will focus on the Microsquirt. A supplementary manual is provided for the 
alternative hardware.

1.1 Emissions and disclaimer
All parts are sold for OFF ROAD RACE-ONLY ground-vehicle use only, or vehicles that pre-date any 
federal and state emissions control requirements. Aftermarket EFI/EMS systems are not for sale or use on 
pollution controlled vehicles. Alteration of emission related components constitutes tampering under the US EPA
guidelines and can lead to substantial fines and penalties. Your country/state/district may also have specific 
rules restricting your tampering with your vehicle’s emissions system.

Race parts are inherently dangerous and may cause injury or damage if improperly modified or altered before 
use. The publishers of this manual will not be held liable for and will not pay you for any injuries or damage 
caused by misuse, modification, redesign, or alternation of any of our products. The publishers of this manual 
will not be held in any way responsible for any incidental or consequential damages
 including direct or indirect labor, towing, lodging, garage, repair, medical, or legal expense in any
 way attributable to the use of any item in our catalog or to the delay or inconvenience caused by the
 necessity of replacing or repairing any such item.

1.2 Required tools
Tuning laptop

Multi-meter (volts, ohms)

Screwdrivers

Wire cutters

Terminal crimpers

Soldering iron and solder

Heat-shrink tubing

Fire extinguisher

Although not essential, the following are highly recommended:

Oscilloscope or scope-meter or soundcard scope

Test light

Power probe

1.3 How to use this manual
This guide includes a number of notes which are indicated as follows:

  This symbol indicates an “Information” note.

  This symbol indicates a “Caution” note.
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  This symbol indicates a “Warning” note.

Installing or tuning your Microsquirt incorrectly can potentially cause damage to your engine, the Microsquirt or 
external hardware. Warning notes indicate specific areas where you need to exercise extreme care. 

Do not rely on these warnings as your only criteria for taking care !

For additional help and support, visit the website   www.msextra.com

1.4 Comparison to GPIO
Another option for transmission control from Megasquirt is the "GPIO board". There are number of key 
differences between the two products that will suit different customers.

The following table compares the two offerings with Microsquirt transmission code running on a Microsquirt and 
GPIO 'MShift' transmission running on a GPIO board.

Item Microsquirt Transmission GPIO Transmission

Software Support for transmissions as a "built in 
recipe" with wiring choices pre-
determined.
Documented in this manual.

Offers a generic approach that can support 
more user-defined configurations. Wiring and
configuration is user determined.
No longer developed or supported.

Assembly Microsquirt is pre-assembled. GPIO is a DIY product requiring extensive 
end-user assembly.

Wiring Pre-made pigtail harness available. 
Needs splicing to transmission 
connectors.
Off the shelf plug and play wiring for 
select transmissions available.

Wiring requires complete assembly.

Expansion capability Pre-assembled Microsquirt hardware is 
not intended to be modified. Small 
number of spare inputs/outputs.

Skilled DIYers can add additional circuits. A 
number of spare inputs/outputs could be 
utilised.

End-user software 
customisation

Source code is provided allowing skilled 
customers to extend functionality if 
desired.

No source code available to customers.
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2 Transmission System Hardware

2.1 Overview 
The transmission controller receives signals from the various input sensors and then controls the solenoid 
outputs to operate the automatic transmission.

Most of the connections will be to the transmission itself. A few additional connections to the engine or main 
ECU are also required.

For engines running Megasquirt, a simple 2-wire CAN connection allows the sensor data to be shared.

For engines that have different fuel injection installed, you will likely be able to tap into the existing sensors.

For engines that do not have existing fuel injection, review the available options in this manual and select the 
most suitable components to complete your install.

2.2 Trans controller (TCU) installation
The Megasquirt products uses automotive grade electronic components internally, however, they are not 
designed to be installed in the engine compartment. Typically they will be installed under the dash in a car or 
under the seat on a bike - but away from direct engine temperatures. The temperature must not exceed 185°F 
(85°C.)

For reference, the dimensions of the Microsquirt mounting hole pattern are 4.20" by 2.14" (107 x 54mm). The 
hole diameters are 0.20" (5mm.)  If full water resistance is desired, the case can be dismantled and sealed with 
a silicone sealant. The wiring plug (AMPSEAL) is an automotive grade sealed connector.

2.3 Wiring Harness and fuses
The transmission controllers are available with "pigtail" wiring harness for you to splice into the existing wiring on
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your transmission. Or for certain transmissions (e.g. 4L80E, 4L60E) "drop-on" wiring is available.

2.4 Sensor Inputs
The sensor inputs provide the TCU with information about current engine operating conditions and are used to 
calculate the solenoid outputs.

The primary inputs are engine speed sensor, speed sensor, gear selector position and TPS/MAP sensor.

2.5 Speed Sensor Input
The TCU needs a connection to read vehicle speed. On most transmissions this is integral with the output shaft,
but some installs may have a connection on a transfer case, differential or on the wheel hub.

2.6 Outputs
The primary outputs are the shift, line pressure and convertor lock-up solenoids.

2.7 Tuning interface
The Megasquirt products use an RS232 interface. Your computer will likely require a USB-serial adapter also. 
Adapter cables based on the FTDI chipset are recommended - some customers have reported unreliability with 
Prolific based cables.

When used standalone, RS232 remains the tuning connection.

When used in conjunction with a Megasquirt-based ECU, the transmission controller can be tuned through the 
engine ECU connection. i.e. a USB cable connects your tuning computer to the engine ECU and the 
transmission controller is connected via CAN.
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3 Wiring and Sensors
A main step in your TCU installation is connecting up the wiring. Be sure to follow the guidance here to avoid 
common mistakes that will often lead to problems.

3.1 Best Practices

3.1.1 Wire and connector choice

For many first-time users, it may be tempting to re-use old connectors and wiring. While this may sometimes be 
cost-effective, beware of false economy. Using fresh connectors and suitable automotive grade wiring can save 
many a headache. Be particularly aware of using wire or components that are not temperature rated high 
enough, engines get HOT and the insulation on sub-standard wires can melt or degrade leading to erratic 
connections or short circuits. All components must be rated for 105°C / 220°F as a minimum.

There are many suppliers dedicated to supplying the required items to construct wiring harnesses.

3.1.2 Soldering or crimping

This is mainly down to personal choice, some installers prefer a soldered joint, others swear that crimped 
connections are superior. The key task is to make a reliable connection.

In your wiring harness you will need to ensure that all joints are effective both electrically and mechanically. 
Always test by tugging on the wires to ensure that they are not loose. Use heat-shrink tubing over connections 
to insulate them and prevent shorts.

With the correct crimpers, uninsulated crimp terminals with a slide on cover will usually give a more professional
and reliable connection than pre-insulated type crimp connectors.

Don't even think about using scotch blocks - they are bad enough for installing a radio or trailer plug!

3.1.3 Re-pinning AMPSEAL

Optionally, to create the smallest wiring harness possible, the AMPSEAL connector may be carefully dismantled 
and unused spare wires removed. Generally it is advised to leave spare wires in place with the ends taped up.

Removing wires from the AMPSEAL connector will make it non-sealed, so this should not be done 
when the sealing is required.

3.1.4 Fusing

It is required that the system be fused - as shown in the general wiring diagram. Remember that an automotive 
battery is capable of supplying hundreds of amps into a short circuit which can easily melt wires or start a fire. 
Appropriate fuses can help reduce this risk and save component damage.

If there is a risk of the connections becoming damp then it can be worth applying petroleum jelly (e.g. Vaseline) 
to the connections to slow the corrosion.

3.1.5 Making the harness

When building the wiring harness, it is strongly advised to run all cables first before attaching ends. Neaten up 
the cable runs and wrap or otherwise attach in place. Only once all the lengths are known and everything is in 
place should ends be crimped. It also helps to make the wiring in one direction. i.e. work inwards towards the 
ECU or outwards towards the accessories - not both. 

3.1.6 4-pin relay pin-out note

Be aware that there are two incompatible "standards" for four-pin automotive relays. Mixing them up will usually 
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cause a short-circuit in your wiring harness. The type where pin 85 is opposite 86 is preferred as this is the 
same as 5-pin relays.

It is highly recommended to use relay-bases, these are easier to mount, look tidier and there is no problem of 
mixing up the wires if a relay is unplugged.

3.1.7 Relay and accessory power routing

Any relays, solenoids or lamps operated by the TCU must only be powered when the TCU is on. Typically it is 
easiest to take their power from the "fuel pump relay" of the main ECU so they are only powered when the 
engine is running. Miswiring accessories can cause power to backfeed into the TCU causing unexpected 
behaviour.

3.2 Grounding (Earthing) Schemes

 Implementing a correct grounding scheme is critical to a successful TCU install. 

Connecting sensors to the wrong ground, using corroded ground points or dubious original wiring are sure-fire 
ways to give you a headache.

There are two key rules:

1. All sensors must ground at the TCU

2. Ground the TCU at the engine block/head using all available power ground wires.

Reasoning:

When a current flows through a wire there is always a voltage drop, the bigger the current, the bigger the drop 
(this is ohm's law.) During cranking there is a very large current flowing through the ground strap from battery to 
engine and perhaps a few volts may be dropped across it. Even during running, a number of amps will flow 
through the TCU grounds to the engine. 

The sensors (coolant, air temp, throttle position, wideband, tach input) all use low current, low voltage signals. 
The TCU measures the voltage from the sensor and converts it into a temperature, position etc. reading. If that 
sensor is grounded to anything other than the ECU itself, then that input voltage will be altered by any external 
voltage drops. For a sensitive measurement this can be a real problem.

Speed input sensors are also sensitive and may show a false speed in the case of poor grounding.

The following two diagrams illustrate good and bad wiring schemes showing where the troublesome voltage 
drops are created and how that would cause sensor readings to be garbage.  
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If re-using or splicing into OEM wiring, do not assume that their wiring is OK. Always follow the above principles.

As a check, with the TCU connector unplugged, ensure that the sensor grounds have no continuity to 
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engine/body ground. Your sensor readings will be junk if they do have continuity - the sensors must ground at 
the TCU only.

3.3 Inputs

3.3.1 Speed sensor inputs

Most transmissions use an inductive (VR) type speed sensor that takes a single from an internal reluctor wheel 
("tone ring"). This input is essential.

 

On the Microsquirt it will likely be necessary to install a 10k "shunt" resistor across VR+/-.

In retro-fit installations, gear-tooth or hall sensors can also be used. (More detail on different options are 
covered in the Microsquirt Hardware manual.) The following shows an open-collector type geartooth sensor that 
requires a pullup resistor in the harness.

 

The TCU can accommodate a speed sensor in different parts of the drivetrain. Identifying the correct location is 
necessary to enable correct speed and output shaft RPMs to be calculated. (The setting names are covered 
again in section 6.6.3.1.)

Wheel

(c) 2014-20 James Murray 2020-10-07 Page 13/74



Trans control setting up and hardware

The speed sensor is picking up on a shaft spinning at the same speed as the wheels. e.g. ABS ring, differential 
ring-gear, wheel studs etc.

The tyre/tire diameter (circumference) is factored in to calculate road speed.

The trans output shaft speed is calculated by multiplying by the final drive ratio.

Driveline

The speed sensor reads output shaft speed directly. (Common on 2WD RWD trans.)

The final drive ratio and tyre/tire diameter (circumference) are factored in to calculate road speed.

Pulses per mile/km

Provides a direct measure of road speed, but accuracy will vary if tyres/tires are changed etc.

The final drive ratio and tyre/tire diameter (circumference) are factored in to calculate trans output shaft speed.

3.3.2 MAP (Manifold Absolute Pressure) sensor

    

This sensor measures air pressure on absolute scale where zero is a complete vacuum and sea-level ambient 
pressure is around 101kPa.

This sensor is optionally used as a load input. (The TCU requires either TPS or MAP for load.)

When using a Megasquirt to operate the engine, use the CAN interface instead of directly wiring the MAP 
sensor.

The sensor has three connections:

A. Ground (sensor return ground)

B. 0-5V analog signal to Microsquirt

C. 5V supply (TPSVREF)

The pressure barb is connected to a full-vacuum source at the intake manifold. When tapping into any existing 
vacuum ports on a throttle body be sure to select one that gives full vacuum when the throttle is closed. (i.e. not 
a "ported vacuum" source that would connect to a distributor.) 

The GM sensors are designed to be installed on the engine, Northstar and LS1 style sensors clip directly into 
the top of the plastic intake.

(c) 2014-20 James Murray 2020-10-07 Page 14/74



Trans control setting up and hardware

0 50 100 150 200 250 300
0

1

2

3

4

5

MAP sensor response

Absolute pressure kPa

V
o

lta
g

e

3.3.3 Transmission temperature sensor

   

This sensor measures the temperature of the fluid in the transmission and could in the future be used to alter 
lockup and shift behaviour. It is not currently used by the TCU software, but is datalogged.

The temperature sensor is a variable resistor (a thermistor). Higher temperatures give a lower resistance, the 
response is non-linear.

The connections to the temperature sensor will be in the transmission multi-plug.  
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The red dots are the three standard calibration points for GM sensors.

The TCU uses a circuit to convert the resistance into a voltage that it measures.
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Sensor calibration

TunerStudio includes many predefined calibration curves to select from, but for other "unknown" sensors the 
three calibration points can be determined.

The manual calibration process requires the use of a multimeter set to measure resistance and ideally a 
thermometer. Without a thermometer your calibration will be fairly close but not perfect.

1. Set the meter to ohms and connect the meter to the two terminals on the MAT or CLT sensor.

2. Allow the sensor to reach room temperature.

3. Take the resistance reading.
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4. Measure room temperature using a thermometer (typically 20°C / 68°F)

5. Place the end of the sensor in a mixture of ice melting in water and allow it to stabilise.

6. Take the resistance reading.

7. Measure the ice/water temperature using a thermometer (typically 0°C / 32°F)

8. Place the end of the sensor in a pan of boiling water and allow it to stabilise.

9. Take the resistance reading.

10. Measure the boiling water temperature using a thermometer (typically 100°C / 212°F)

You now have the three calibration points for TunerStudio.

For a GM sensors these should be close to:

Where °C °F Ohms

Ice/water 0 32 9441

Room temp. 20 68 3518

Boiling water 100 212 172

Note that the default calibration data in TunerStudio goes down to -40° but that's rather difficult to measure in 
the normal workshop.

3.3.4 Engine Temperature (CLT) sensor

     

This external sensor measures the temperature of the engine coolant (or cylinder head for air-cooled engines.) It
is not currently used by the TCU software, but is datalogged.

The coolant temperature is a thermistor and works in the same way as the air temperature sensor.

When using a Megasquirt to operate the engine, use the CAN interface instead of directly wiring the engine CLT
sensor.

  

A good sensor will have two wires, one wire connects to sensor ground, the other to the CLT input on the ECU.

One-wire sensors are not recommended.
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3.3.5 TPS (Throttle Position Sensor)

     

This external sensor measures the position of the throttle plate. It is a variable resistor (potentiometer) and 
sends a 0-5V signal back to the TCU. The sensor has three wires, 5V supply (TPSVREF), Ground (sensor 
ground return) and signal. The TCU converts the signal to a 0-100% scale using your calibration numbers. 0% 
corresponds to fully closed, 100% to fully open.

This sensor is optionally used as a load input. (The TCU requires either TPS or MAP for load.)

When using a Megasquirt to operate the engine, use the CAN interface instead of directly wiring the TPS.

3.3.6 Brake Switch input       

The optional brake-switch input is used to unlock the convertor during braking for smoother operation. On the 
Microsquirt the "FLEX" input is used.

  

3.3.7 CAN comms 

The CANH/L wires are used to connect the TCU to a master Megasquirt ECU to share data and reduce 
redundant wiring.

 

The following diagram illustrates the basic CAN wiring principles.

In general, CAN forms a bus network with a 120R terminator at each end and devices wired as short 'drops' off 
the network. 
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The Megasquirt-3 and Microsquirt include terminating resistors internally, so can be used at the ends of the 
network. However, if additional devices are connected to the network, they must not have terminating resistors ! 
i.e. one at each end only.

Connect:

Microsquirt CANH -> ECU CANH

Microsquirt CANL -> ECU CANL

3.4 Outputs
The main outputs from the TCU are low-side drivers for the transmission solenoids. Refer to the wiring tables for
exact connections.

 

Some transmissions require high-side drivers in their factory configuration i.e. the solenoids are grounded and 
the ECU provides 12V to activate them. It may be possible to re-wire as low-side or you may need a high-side 
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driver circuit.

3.4.1 EPC (line pressure solenoid) output

It is strongly recommended to install an additional external diode across the EPC solenoid. This results in far 
greater control of line pressure.
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4 TCU Wiring Tables
Each hardware variant has its own wiring table, be sure to refer to the correct one! Transmission wiring is 
covered in the next section.

4.1 Microsquirt V3 trans wiring
To use the Microsquirt V3 as a transmission controller, no internal modifications or customisation is required.

Pin# Name Color In/Out Function Max
current

1 +12V In Red In Main power feed < 1A

2 CANH Blue/Yellow Comms CAN communications -

3 CANL Blue/Red Comms CAN communications -

4 VR2+ VR2 In Engine speed signal. Connect to 
tacho or crank sensor. OR Input 
shaft speed sensor. *2

-

5 SPAREADC2 (MAF) Pink/Black In Spare analogue input. -

6 FLEX Purple/White In Brake switch GND signal. Do not 
apply 12V to this pin.

-

7 FIDLE Green Out Solenoid B 3A

8 FP (pump) Purple Out Solenoid A 3A

9 INJ 1 Thick Green Out TCC (LU) Solenoid 5A

10 INJ 2 Thick Blue Out EPC solenoid 5A

11 SPK B (IGN2) Thick White/Red In Selector pos B -

12 SPK A (IGN 1) Thick White In Selector pos A -

13 RX - Comms RS232 communications -

14 TX - Comms RS232 communications -

15 BOOT LOAD Purple/Black In Bootloader GND enable input -

16 ALED Yellow/Black Out Solenoid D 3A

17 WLED Yellow/White Out Solenoid C 3A

18 Sensor Ground - GND Not installed -

19 Serial Ground - GND Serial Ground -

20 Sensor Ground White/Black GND Sensor GND (temp,TPS) -

21 VR2- VR2 In Engine Speed signal OR Input shaft 
speed sensor. *2

-

22 POWER GROUND Thick Black GND POWER GROUND -

23 POWER GROUND Thick Black GND POWER GROUND -

24 MAP Green/Red In Optional input. *3 -

25 CLT Yellow In Engine Temp Sensor (if used) *3 -

26 MAT Orange In Trans temp sensor -

27 TPS Blue In TP Sensor input (if used) *3 -
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Pin# Name Color In/Out Function Max
current

28 TPS VREF (5V) *1 Gray Out 5V supply for TPS 0.1A

29 SPAREADC Orange/Green In Selector pos C or Analogue gear pos -

30 OPTO+ Grey/Red In Do not connect -

31 OPTO- Grey/Black In Do not connect -

32 VR1+ VR1 In VSS (rear/side of trans or transfer 
case)

-

33 VR1- VR1 In VSS (rear/side of trans or transfer 
case)

-

34 O2 Pink In Selector pos D (OD) -

35 TACHO Green/Yellow Out Optional output. 0.3A

Note *1

TPSVREF is used to power TPS

• Connect to TPS if using it standalone. Do not connect if sharing TPS with another ECU.

Note *2

VR2+/- is used for either engine speed or input shaft speed.

• When fetching data from a Megasquirt ECU over CAN, these inputs are available for an input shaft 
speed sensor

• When operating standalone without a CAN connection, these inputs must be used as an engine speed 
input.

Note *3

When fetching data from a Megasquirt ECU over CAN the following wired connections are not needed to the 
trans controller.

• Engine TPS

• Engine MAP

• Engine CLT

The "BOOTLOAD" wire should not be connect to anything - leave it safely taped up.

4.2 Microsquirt V1, V2, MS2, GPIO trans wiring
Wiring and customisation for these alternative hardware platforms is covered in the supplementary manual.
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5 Transmission Specific Wiring
Each transmission has its own wiring. These tables cross reference the input and output names used in the 
previous section.

Selector input and solenoid output tables are provided to aid fault-finding.

5.1 GM 4L80E
Fully supported.

Early connector (prone to leakage)

Later connector (1993+)
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Function / TCU connection Early 4L80E Late 4L80E

Solenoid A A A (Light Green)

Solenoid B B B ( Yellow/Black)

+12 Power C & K E (Pink/Black)

Selector pos A D N (Pink)

Selector pos B E R (Blue)

Selector pos C F P (Red)

Temp Sensor GND H M (Purple)

Temp Sensor G L (Black/Yellow)

LU Sol Switched Gnd J S (Brown/Black)

EPC +12V L C (Red/Black)

EPC Switched Gnd M D (Grey/White)

The transmission requires a fused 12V supply. A 10A fuse to supply both +12V and EPC is recommended.

The output shaft VSS VR sensor (the one near the rear of the trans) is connected to VR1

The input shaft VR sensor (the one near the middle of the trans) is connected to VR2 when running alongside a 
Megasquirt ECU and fetching engine RPM over CAN. (In standalone mode, VR2 is used for engine RPM and 
the input shaft VR sensor cannot be used.) The input shaft speed sensor is mounted 'downstream' of the 4th 
gear overdrive gearset, so reported convertor slip will include any overdrive clutch slippage.

Built-in gear ratios: 2.48,1.48,1.00,0.75

5.1.1 Selector inputs

Gear Selector A B C gearselin

P 1 0 1 2

R 0 0 1 6

N 1 0 1 2

D 1 0 0 3

3 1 1 0 1

2 1 1 1 0

1 0 1 1 4

0 = ground to TCU, 1 = open circuit to TCU (high). Ground-switching input expected.

5.1.2 Solenoid outputs

Gear range 1-2 2-3

P On Off

R On Off

N On Off
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4 On On

3 Off On

2 Off Off

1 On Off

Off = open circuit from TCU, On = ground output from TCU. Low-side output.

5.2 GM 4L60E
Fully supported.

 

Function 4L60E

Solenoid A A

Solenoid B B

+12 Power E

Selector pos A N

Selector pos B R

Selector pos C P

Temp Sensor GND M

Temp Sensor L

LU Sol Switched Gnd T

EPC +12V C

EPC Switched Gnd D

3-2 solenoid switched Gnd (Solenoid C) S

Lock up feel solenoid switched Gnd (later models)

(Solenoid D)
U
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The transmission requires a fused 12V supply. A 15A fuse to supply both +12V and EPC is recommended.

The "3-2 solenoid" connects to "Solenoid C"

On 1993+ models, "Lockup feel solenoid" connects to "Solenoid D". Be sure to enable LUF on the lockup menu.
Without this additional solenoid control, very slow lockup can burnup the lockup clutch.

Built-in gear ratios: 3.06,1.63,1.00,0.70

5.2.1 Selector inputs

Gear Selector A B C gearselin

P 1 0 1 2

R 0 0 1 6

N 1 0 1 2

D 1 0 0 3

3 1 1 0 1

2 1 1 1 0

1 0 1 1 4

0 = ground to TCU, 1 = open circuit to TCU (high). Ground-switching input expected. 

5.2.2 Solenoid outputs

Gear range 1-2 2-3 3-2

P On Off 90%

R On On 0%

N On Off 90%

4 On Off 90%

3 Off Off 90%

2 Off On 90%

1 On On 0%

Off = open circuit from TCU, On = ground output from TCU. Low-side output.

5.3 Toyota A340/A341E
In use by a small number of customers.

This application expects high-side gear position switches. i.e. they provide a 5V signal instead of a ground.

May also include A340.

Built-in gear ratios: 2.53,1.53,1.00,0.71

5.3.1 Selector inputs

Active high switch inputs are expected, matching the 4L80E pattern per user request.

Gear Selector A B C gearselin

P 0 1 0 2

R 1 1 0 6

N 0 1 0 2
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D 0 1 1 3

3 0 0 1 1

2 0 0 0 0

1 1 0 0 4

0 = ground to TCU, 1 = high (5V) to TCU.

An external interface circuit is required currently.

Note that a future firmware release is likely to eliminate this circuit and use just the three signals from the 
selector switch.

 

5.3.2 Solenoid outputs

Gear range 1-2 2-3

P Off Off
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R Off Off

N Off Off

4 Off Off

3 Off On

2 On On

1 On Off

Off = open circuit from TCU, On = ground output from TCU.

SLT EPC = line pressure  = Microsquirt EPC

SLU = converter lockup = Microsquirt TCC (LU)

SLN = Accumulator backfill solenoid = Microsquirt Solenoid C

The trans expects a high-side drive to the solenoids (S1 and S2 only?), so either the trans must be re-wired 
internally to low-side or a high-side driver circuit installed.

5.4 Chrysler 41TE
The 41TE is no longer supported.

5.5 Ford 4R70W
In use by a small number of customers.

This transmission operates in a similar fashion to the GM 4L80E, but has the choice of either an analogue gear 
position input or a set of switches (digital range selector / DRS). The software must be set to either digital or 
analogue to match your selector and wiring.

Built-in gear ratios: 2.84,1.55,1.00,0.70

5.5.1 Selector inputs

In switch mode, the table applies. In analogue mode, set the voltages to match the analogue range position 
sensor.

Gear
Selector

Switch mode
gearselin VoltageA / TR1 B / TR2 C / TR4

P 1 0 1 2

R 0 0 1 6

N 1 0 1 2

D 1 0 0 3

3 1 1 0 1

2 1 1 1 0

1 0 1 1 4

0 = ground to TCU, 1 = open circuit to TCU (high). Ground-switching input expected.

For the digital range selector (switch) the following wiring applies.

TR1 -> sel A

TR2 -> sel B

TR3 = not used
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TR4 -> sel C 

There is a common ground on the range selector which connects to 'Sensor Ground.'

5.5.2 Solenoid outputs

Gear range 1-2 2-3

P On Off

R On Off

N On Off

4 On On

3 Off On

2 Off Off

1 On Off

Off = open circuit from TCU, On = ground output from TCU. Low-side output.

5.6 GM 4T40E
Fully supported. Uses switch inputs B&C only.

Built-in gear ratios: 2.95,1.62,1.00,0.68

5.6.1 Selector inputs

Gear
Selector

Switch mode
gearselinA B C

R x 1 0 1 or 5

N x 1 1 0 or 4

D x 0 1 2 or 6

0 = ground to TCU, 1 = open circuit to TCU (high). x = ignored. Ground-switching input expected.

5.6.2 Solenoid outputs

Gear range 1-2 2-3

P On Off

R On Off

N On Off

4 On On

3 Off On

2 Off Off

1 On Off

Off = open circuit from TCU, On = ground output from TCU. Low-side output.

5.7 GM 5L40E
In development, testers required.

Built-in gear ratios: 3.42,2.21,1.60,1.00, 0.75
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5.7.1 Selector inputs

Gear
Selector

A B C P (D) gearselin

P 0 1 1 0 12

R 0 0 1 1 6

N 1 0 1 0 10

D 1 0 1 1 2

4 0 0 0 0 15

3 0 1 0 1 5

2 1 1 0 0 9

0 = ground to TCU, 1 = open circuit to TCU (high). Ground-switching input expected.

5.7.2 Solenoid outputs

Gear range 1-2 2-3 4-5

P Off Off On

R On Off Off

N Off Off On

5 Off Off Off

4 Off Off On

3 On Off *

2 On On *

1 Off On *

Off = open circuit from TCU, On = ground output from TCU. Low-side output.

* in manual ranges 1,2,3 this solenoid is engaged to enable engine-braking.

5.8 Ford E4OD
In use by a small number of customers.

This has the choice of either an analogue gear position input or a set of switches. Drive should be defined as 
gear 4.

The coast clutch connects to 'Solenoid C' output

The OD cancel switch connects to input 'Selector D' 

Built-in gear ratios: 2.71,1.54,1.00,0.71

5.8.1 Selector inputs

In switch mode, the table applies. In analogue mode, set the voltages to match the analogue range position 
sensor.
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Gear
Selector

Switch mode
gearselin Voltage

A B C

P 0 0 0 7

R 0 0 1 6

N 0 1 0 5

D 1 1 1 0

2 1 0 1 2

1 1 1 0 1

0 = ground to TCU, 1 = open circuit to TCU (high). Ground-switching input expected.

5.8.2 Solenoid outputs

Gear range 1-2 2-3 Coast
clutch

P On Off Off

R On Off Off

N On Off Off

4 Off Off Off

3 Off On *

2 On On *

1 On Off *

Off = open circuit from TCU, On = ground output from TCU. Low-side output.

* in manual ranges 1,2,3 this solenoid is engaged to enable engine-braking.

5.9 Subaru W4A33
In use by a small number of customers.

From the factory this uses multiple switches to determine level position. A resistor network is required to 
generate a 0-5V analog signal to the TCU. 'Drive'  should be defined as gear 3.

The OD cancel switch connects to input 'Selector D'  This will allow the shift into 4th gear.

The solenoids are designed to be fed 12V. Either these need re-wiring to be ground switched or PNP drivers 
(e.g. TIP125) used to power them.

Built-in gear ratios: 2.55,1.49,1.00,0.69

5.9.1 Selector inputs

As above, an analogue input is expected.

5.9.2 Solenoid outputs

Gear range A B

P On Off

R On Off

N On Off
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4 On Off

3 Off Off

2 Off On

1 On On

Off = open circuit from TCU, On = ground output from TCU. Low-side output.

The trans expects a high-side drive to the solenoids, so either the trans must be re-wired internally to low-side or
a high-side driver circuit installed.

5.9.3 Other applications

To follow. Please engage with the developers on the www.msextra.com forum or through your supplier.

(c) 2014-20 James Murray 2020-10-07 Page 32/74

http://www.msextra.com/


Trans control setting up and hardware

6 Software
This section covers loading the firmware to your TCU and basic configuration settings.

6.1 Install TunerStudio and MegaLogViewer
You ECU is tuned using TunerStudio on a Windows, Mac or Linux computer.

If your ECU came with an install CD or pen drive, run it now to install the software.

The latest versions can be downloaded from www.msextra.com/downloads

For Linux, your current user needs to be a member of the 'dialout', 'lock' and/or 'uucp' groups in order to access 
your comms port.

6.2 Power up your TCU
Now it is time to power up the TCU. Either in the vehicle or on the bench, apply a fused 12V supply to power 
and ground inputs.

6.3 Direct connection for firmware loading or standalone operation

6.3.1 Get the serial comms set up

Plug'n'play ECUs will usually be supplied with the firmware loaded and a tune ready for use. In these case there
is no reason to load new firmware or connect to the TCU by serial and you can skip to step 6.4.

The Microsquirt uses RS232 serial communications for tuning with a standard DB9 female connector. Some 
older or "industrial" type laptops will include a true serial port, most computers only have USB and a USB-serial 
adapter will be required. FTDI based cables are recommended.

 Microsquirt serial cable.

 Standard DB9 male connector on computer.
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 Standard DB9-DB9 straight through serial cable.

 Computer USB socket

 Typical USB-serial adapter

Before inserting a USB-serial adapter, follow the manufacturers' instructions for driver configuration.

(Windows only) Having found your true serial port or plugged in your USB-serial adapter, it is desirable to 
opening up Device Manager and identify the COM port number. The method to open Device Manager changes 
with each Windows version, so will not be documented here.
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The above is a screenshot from Windows XP, showing the Device Manager and the sub-panes showing that this
USB-serial adapter has been assigned COM1 - remember that number!

If you DO NOT see "Ports" listed in the devices then you do not have any ports setup. This would usually 
indicate either you forgot to plug in your USB-serial cable or there is a driver problem. Usually the best solution 
to the driver problem is to unplug the cable, uninstall the driver and then re-install the driver.

Alternative (Windows only) - download and run portcheck.exe from www.msextra.com/downloads

  

Take a note of the COM port number listed above. In this case it was COM1.

Should you encounter problems getting your serial connection working, refer to the fault finding section.

6.3.2 Turn off "Hide extensions for known files types" (Windows Only)

Windows has a feature to hide part of the filename. It is strongly advised that this is disabled to prevent 
confusion.

Go to Folder Options  (Use Search to find it if required.)
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Ensure that "Hide extensions for known files types" is not ticked.

6.3.3 Download the firmware if required

Plug'n'play ECUs will usually be supplied with the firmware loaded and a tune ready for use. In these case there
is no reason to load new firmware and you can skip to step 6.4.

For most other situations you will need to load in the current firmware version to the ECU before you begin 
tuning.

The latest versions can be downloaded from the transmission control section of  www.msextra.com/downloads 
save the zip file to a known location as shown in the next steps.

By default your web browser will save the downloaded zip file to "Downloads" or similar. Make sure you can find 
the file you have downloaded! Your web browser may have a "show in folder" option for the download or open 
up the file explorer and find it.

You are looking for a file similar to trans-release-1.1.zip  (If you don't see the ".zip" on the end, check your 
folder options and make sure the hide extensions is NOT ticked.) 
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Open up this zip file to see the contents, it includes the firmware files and default tune files (i.e. the 'base map' 
that you get when you reload the firmware.)

 

The trans directory contains the sourcecode, this is only needed for advanced customers that want to modify 
the operation of the TCU way beyond normal tuning. Most customers can safely ignore this.

6.3.4 Install the firmware if required

For information: the old text-based firmware loader is covered in section 8.

Open TunerStudio. Close any open Projects.
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From the Tools menu, select Update / Install Firmware.

Next.

 

Pick your serial connection, then Next.

Note that TunerStudio may find a connection as both a D2XX device and an RS232 device; the D2XX 
connection is simply a newer driver version for USB adapters and is the preferred method if connecting over 
USB.
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Tick the box for Other/Browse and then browse the file system on your computer to find the firmware zip file. 

If you just downloaded it, it will probably be in your "Downloads" folder.

 

Click Open, then Next on the previous screen.

You'll then be stepped through license and readme information screens.
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After accepting the license terms and passing through the readmes, you'll reach this screen.

In this example, we are loading firmware to a fresh 'blank' processor, so be sure NOT to Preserve Sensor 
Calibrations as there is nothing to preserve.

When loading firmware to a 'blank' processor, the firmware loader has an additional step of loading a bootstrap 
loader. Follow the on-screen instructions.
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After clicking Next, the firmware will start loading.

If this takes longer than a minute then you probably didn't adjust the FTDI latency setting.

In rare cases, the first time you install firmware it might be necessary to use the boot jumper. For MS2 or 
Microsquirt-module - apply the shunt to the B/LD pins on the card. For Microsquirt, connect the "BOOTLOAD" 
wire to ground. 

When the loading process has completed, you can click Finish.
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If it can, TunerStudio will try to load your tune and settings back into the ECU.

If this is a first load, you are now ready to continue by creating a project and configuring the ECU for your 
engine, head back over to the Setting Up Manual for more instructions.

If this was an upgrade you need to reload your tune and check through the "gotcha" items highlighted during the
load process.

Always recheck your settings and verify your sensors are reading correctly after loading new firmware. 

 

6.4 Get your tuning computer to talk to the ECU - standlone TCU
For operation in conjunction with a compatible MS2 or MS3 ECU it is recommended to add the TCU to your 
main ECU Project in TunerStudio to allow concurrent tuning via CAN. Skip this section and move to section 6.5.

For standalone operation (i.e. TCU only with no compatible ECU) your tuning computer will be connected 
directly to the TCU by serial and you will have a TunerStudio project for the TCU.

(Even in combined ECU/TCU environments it may be useful for troubleshooting purposes to connect directly to 
your trans controller through the serial port and create its own TunerStudio project.)

i. Start TunerStudio

ii. Create a new project.

From the Start Screen select File > New Project

or from the Main Screen select File > Project > New Project.
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In the Project Name box you can give the project a meaningful name if wish.

Double check that your TCU is powered up and connected to your computer by serial.

iii. Click on Detect

When you click the “Detect” button a “Detect Device” screen will appear and TunerStudio will attempt to find 
your TCU and its firmware version. If successful it will list your TCU, firmware version and Baud rate. Check to 
see that these appear to match your TCU and then click “Accept” to continue. If the “Detect Device” screen 
reports “No controller found” check the connection between your computer and your TCU and ensure that your 
TCU has power and try again. If this still does not resolve the problem move on to the “Other / Browse” method 
described below to set the firmware up manually.

 

If your TCU is identified correctly, clicking “Accept” should load the necessary firmware version. Click Next and 
you can now move on to step v.

If your TCU is identified correctly but clicking “Accept” displays a message that reports “TunerStudio does not 
have a configuration to support the found hardware” then it is likely either that you are running an older version 
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of TunerStudio, or you are running a beta version of the firmware. If you are running an older version of 
TunerStudio you are strongly advised to update to the latest version. If you are using a beta version of the 
firmware you will need to use the “Other / Browse” method described below to set up your firmware manually. 

iv. Other / Browse

This method is recommended only if TunerStudio is not able to detect your TCU, or if you are using a beta 
version of the firmware.

The firmware on your TCU may have been provided on a disk or downloaded as a .zip file from the 
www.msextra.com website. If you have downloaded your firmware and haven't done so already extract the 
contents of the zip file to a directory of your choice.

Clicking in the box next to “Other / Browse” opens a screen which lets you browse to your firmware folder. From 
here you should be able to select the .ini file that you want to use. It is essential that you use the .ini file that is 
appropriate to your TCU.

The .ini file you are looking for is called  trans.ini

(Your computer may hide the .ini part from you - if this is the case, go to Folder Options and ensure there is no 
tick beside "Hide known file extensions". Unticking this can help protect against accidentally running viruses 
too.)

Select the file and then click Next.

v. Project Settings

  

The settings available on this list may vary based on your firmware. Verify that what they are configured to 
match your set up. If you are unsure, the default values are likely to work well. These settings can be changed 
after your project has been created.

vi. Comms parameters
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Generally these can be left alone. Click Next.

vii. Dash

 

Click Finish.

The standard dash should display.
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6.5 Adding trans control to your ECU TunerStudio project
This requires that you have a main Megasquirt ECU (MS2 or MS3) running your engine and have connected the
trans controller by CAN. TunerStudio needs to be configured and have a running connection to you ECU. (If you
run into any difficulties here, you may consider configuring a direct connection as per section 6.4.)

With TunerStudio open and your main ECU project loaded and connected (online)

File -> Project -> Project Properties -> CAN Devices will show the following screen with nothing configured:

 

Click on the  button and then set the "Device CAN ID" to 7 (*CRITICAL*)

Optionally type in the Device Identifier and Device Description.

(c) 2014-20 James Murray 2020-10-07 Page 46/74



Trans control setting up and hardware

 

Click on the three dots button to browse for the "Device Configuration File" (ini file)

This will then open up a file browser window. The file you are looking for is "trans.ini" and is supplied with the 
trans controller firmware. i.e. in the zip file.

(Your computer may hide the .ini part from you - if this is the case, go to Folder Options and ensure there is no 
tick beside "Hide known file extensions". Unticking this can help protect against accidentally running viruses 
too.)

Set the temperature units if desired.

 

Click Ok.

The project will then re-load and TunerStudio will fetch the current settings from both your main ECU and the 
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trans controller.

You can use the dropdown in the top left of the screen to choose which tuning menus to display:

 

The tabs at the bottom of the screen allow you to switch between main ECU and trans controller dashboards.

When datalogging to your tuning computer, you will get a datalog of ECU data and trans control data.

For MS3 SDcard datalogs, only data that is available within the MS3 is available for logging. See section 7.2.

6.6 Tuning menus
The following sections show some of the tuning screens. These may be subject to change due to on-going 
software enhancements.

6.6.1 TunerStudio Tooltips

Throughout the software you will find Tooltips - clicking on the [?] will bring up explanatory text.

  

6.6.2 Tools menu

6.6.2.1 Calibrate TPS

This only applies if you are using a directly connected TPS. It is not required if you are using TPS data from the 
master ECU over CAN.

 

To calibrate the throttle position sensor do the following:

1. Ensure that your TCU is connected and the engine is not running (i.e.,  KOEO).
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2. Ensure that the throttle is closed;

3. Click the “Get Current” button to the right of “Closed throttle ADC count”;

4. Fully open the throttle;

5. Click the “Get Current” button to the right of “Full throttle ADC count”;

6. Click Accept and your throttle sensor will be calibrated.

6.6.2.2 Calibrate MAP sensor

This only applies if you are using a directly connected MAP sensor. It is not required if you are using MAP data 
from the master ECU over CAN.

 

The Common MAP Sensors gives a list of the commonly used MAP Sensors. If you are using one of these 
sensors select if from the drop down list, otherwise select “Custom” and enter the required numbers.

(MS2 kits are usually supplied with a MPX4250AP sensor.)

6.6.2.3 Un/Lock Calibrations

The calibration settings for Thermistor Tables can be locked or unlocked to prevent them from being changed 
accidentally.

 

Select Unlocked and then Close.

6.6.2.4 Calibrate Thermistor Tables

Megasquirt ECUs are supplied loaded with the correct calibrations for GM temperature sensors. You only need 
to go through this calibration process if you are using different sensors.

A process for determining the calibration numbers is shown in the inputs section of this manual.
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Sensor Table

Select whether you are using a “Local Engine Temperature Sensor” or a “Trans Temperature Sensor”.

Table Input Solution

This value will normally be set to “3 Point Therm Generator”.

Common Sensor Values

From this option you can select your sensor type. You can select from a predefined list of common sensors from
the drop down list, or leave this option unselected if you are using custom settings specific to an unlisted sensor.

Bias Resistor Value (Ohms)

This is 2490 ohms unless you or your vendor have changed the resistors inside the TCU.

Temperature Settings (°C or °F)

Again, if you have selected one of the common sensors these values should be set for you. If you are using a 
custom sensor enter the three measured temperature and resistance value pairs.

Write to Controller

Once you have completed the settings in this screen click the “Write to controller” button to burn these settings 
to your TCU.

Repeat for the both sensors if required.
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6.6.3 Trans Controller Setup

6.6.3.1 Base Settings

 

No. Cylinders / rpm divider: Set this to give the correct engine RPM. Typically this is the number of cylinders. 
Only used when not fetching engine RPM via CAN.

Hardware in use: The specific hardware and wiring scheme you are using.

• MS2 = Megasquirt-2 ECU

• Microsquirt = Obsolete metal cased V1 and V2 Microsquirt

• GPIO = GPIO board

• Microsquirt V3 = current plastic cased Microsquirt    (This is what most customers should select.)

For current plastic cased Microsquirt, but sure to select "Microsquirt V3"

Apply common settings: Selecthe automatic transmission/gearbox type in use. This will this fill in the next 
setting and the typical gear-ratios.

Transmission type: The automatic transmission/gearbox type in use (auto-filled by previous setting.)
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Load input for shift curves: Whether to use TPS or MAP as the load index for the shift curves.

Load input for line pressure: Whether to use TPS or MAP as the load index in the line pressure curves. 
Boosted applications may work better using MAP.

Line pressure curves: Whether to use a common line pressure curve (recommended) or individual curves per 
gear.

EPC frequency: Later 4L80E use 595Hz (most common), early used 297Hz

Brake Switch Enable: Whether to use the optional brake switch input (cancels lockup.)

Brake Switch Polarity: Whether a high (5V) or low (ground) input means the pedal is pressed.

Use CAN for TPS/RPM/CLT: Whether TPS and engine RPM are connected directly to the trans controller for 
standalone operations or if they are fetched over CAN from a Megsquirt ECU. The 'Listen to CAN broadcast" 
option requires that 'Dash Broadcasting' be enabled on the main ECU.

Remote CAN ID: The CANid of a Megasquirt ECU to fetch TPS and engine RPM from. Typically 0.

My CAN ID: Set to 7 for normal operation.

Preferred Speed Units: Chooses the speed units - either Mile-per-hour or Kilometres-per-hour. Close the page 
and re-open after changing.

Preferred Length Units: Chooses the size units - either metres or inches. Close the page and re-open after 
changing.

OD cancel button mode: Selects how the overdrive (OD) cancel switch/button operates.

• Latching: An on/off switch the cancels or allows overdrive.

• Momentary: A push-button. Requires the TCU to latch the on/off state.

OD/cancel light: Enables an OD mode light output and selects the raw output pin to use.

VSS Position/Type: Where the speed sensor is mounted (See also section 3.3.1)

• Wheel: Directly on the wheel/hub. Select this when your sensor is picking up on a shaft spinning at the 
same speed as the wheels. e.g. ABS ring or wheel studs.

• Driveline: on the driveline/trans. Select this when your sensor is picking up on a shaft before the final 
drive gear. e.g. gearbox output shaft, propshaft. (This is most likely the setting to use for RWD 
transmission mounted sensors e.g. 4L80E, 4L60E etc..)

• Pulses per mile: a sensor that provides a pulses-per-mile signal

• Pulse per km: a sensor that provides a pulses-per-mile signal

• Listen to CAN broadcast: Shares 'Dash Broadcast' data from Megasquirt ECU. Must be enabled on 
master ECU and in 'Use CAN for TPS/RPM/CLT' setting also.

Wheel diameter: The rolling diameter for wheel and tire/tyre. (Check your units are set correctly.)

Final drive ratio: Differential ratio or any gear reduction between transmission output shaft speed sensor and 
wheel speed.

Pulses: Number of pulses per mile/km when pulses per mile or km is selected.

Trans speed sensor # teeth: Effective number of teeth on VSS.

Input speed sensor # teeth:  Effective number of teeth on input shaft speed sensor.

Ratio Choice: Use built-in standard gear ratios for this transmission or select custom ratios.

1st gear ratio: The ratio of each gear in the transmission. (These are auto-filled when you 'Apply common 
settings')
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VSS Output: Enables a VSS output (for dash speedo) and selects the raw output pin to use.

VSSout Units: Chooses between:

• time - user customisable scaling factor entered in the next box

• pulses per mile - standard pulses per mile entered in the next box

• pulses per km - standard pulses per km entered in the next box

Scale: Pulses per mile/km or time scaling factor.

6.6.3.2 Shift Settings

 

Settings

Automatic / manual mode: Selects between:

• Auto - standard automatic mode using shift curves

• Manual - full manual, gear is determined by selector only

• Manual - selectable - an input is used to switch between full manual and automatic modes

Manual input switch: where a ground-switch input is used. Grounded = manual mode.

RPM based up-shifting: Selects to use RPM limits instead of VSS shift-curves above set TPS.

TPS threshold: Above this TPS threshold the RPM limits will be used only.

Predictive up-shifting: Under WOT conditions, uses the current acceleration rate to predict when shift RPM 
will be reached to reduce overshoot.

Minimum RPM for predictive: Minimum RPM to use for predictive shifting, typically set to your convertor stall 
speed or higher.

Settle time before shifts: Time to allow conditions to settle. e.g. time to go from partial throttle to WOT. If the 
code reacts too quickly it can choose the wrong gear.

Retard timing during shifts: Enables sending a CAN command to retard engine timing during shift. (Requires 
a CAN connection to a Megasquirt ECU controlling the engine.)

Duration of retard: Duration of timing retard.
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Remote table: CAN parameter for remote table. Standard is 7 for MS3 and MS2/Extra.

Remote offset: CAN parameter for remote offset. At time of writing, MS3 is 632, MS2/Extra is 514.

Shift  Retard

The curve specifies how much to retard the ignition timing by during the shift based on the load (TPS or MAP)

Some weaker transmissions may require timing to be retarded during high load shifts. Shifts at low loads are 
unlikely to need any retard.

6.6.3.3 Shift Delays and Max RPM

Common or individual delays: Whether to enable individual delay settings for each gear to use simplified 
common delay numbers.

Delay before shift: Delay time in transmission from solenoid activation before it starts to change gear. Any 
timing retard begins after this time.

Delay after shift: Delay time in transmission to complete gear change. A new gear change will not be requested
until after this time.

The per-gear settings all specify changes into this gear. i.e. up-shift 2 means 1->2. Down-shift 3 means 4->3.

Up-shift delay: Delay time in transmission from solenoid activation before it starts to change gear. Any timing 
retard begins after this time.

Up-shift time: Delay time in transmission to complete gear change. A new gear change will not be requested 
until after this time.

Down-shift delay: Delay time in transmission from solenoid activation before it starts to change gear. Any 
timing retard begins after this time.

Down-shift time: Delay time in transmission to complete gear change. A new gear change will not be requested
until after this time.

For each gear you can set a maximum RPM.

• In automatic mode, if the engine RPMs reach the maximum for that gear, the controller will upshift if 
possible - even if the upshift wheel speed is not met.
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• In RPM-based upshift mode, the limits are used as the shift point.

• In full manual mode, the RPM limits will not trigger a shift. i.e. they are ignored.

 

6.6.3.4 Lockup Settings

These settings control the behaviour of the lockup torque convertor. Locking the convertor reduces slip, power 
loss and heat generation. Typically the convertor will be locked in high gears at during cruise.

  

Settings

VSS hysteresis: Hysteresis (deadband) in wheel speed for lockup.

Load input for lockup: Whether to use TPS (default) or MAP as the load parameter.

Lockup min load: Minimum load to lockup convertor.

Lockup max load: Maximum load to lockup convertor.

Lockup solenoid type: Lockup solenoid is variable/pulsed (most transmissions) or on/off only.

Lockup wait time: Delay before starting lockup cycle. A few seconds is typical.

Lockup start duty: TCC solenoid duty at start of lockup cycle.

Lockup rise time: Time to ramp up TCC duty.

Lockup full duty: TCC solenoid duty when locked.

Lockup end duty: TCC solenoid duty after unlock.

Lockup decay time: Time to ramp down TCC duty.

Locked during shifts: Whether to remain locked up during shifts, usually set to Off.

Unlock delay before shift: Time after unlock before shift starts. This allows for mechanical delays in the 
solenoids and lockup clutch.
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Use LUF solenoid: This is a 4L60E specific option. Enables the Lock-Up-Feel (LUF) solenoid in the 1993+ 
4L60E. In this case the TCC solenoid is on/off and LUF is PWM.

Lockup per Gear

This allows the individual lockup parameters per gear to be set. Lockup can be enabled or disabled for each 
gear and minimum RPM and wheel speeds set.

Enable: Enables or disables lockup in this gear.

Min RPM: The minimum RPM to allow lockup.

Min VSS: The minimum VSS to allow lockup.

6.6.3.5 Lockup Race Settings

 

Race mode: Enables race-only lockup settings.

Min TPS for race mode: Minimum TPS to lockup convertor when in race mode.

Unlock delay before shifts: Time after unlock before shift starts in race mode. This allows for mechanical 
delays in the solenoids and lockup clutch. Note that this may delay shifts requiring a lower shift point.

For each gear you can choose whether to enable lockup, the RPM, VSS and lockup shift parameters.

Lockup: Whether to enable lockup in this gear in race mode.

Min RPM: Minimum RPM required to lockup in this gear in race mode. (Both RPM and VSS limits must be met.)

Min VSS: Minimum VSS required to lockup in this gear in race mode. (Both RPM and VSS limits must be met.)

Locked during upshift: Whether to stay locked during upshift from this gear.

Lockup delay: Re-locking delay after shifting INTO this gear.
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6.6.3.6 Gear Position

 

For each gear, specify the analogue voltage at the processor.

Some selectors already provide a 0-5V signal from the factory. In other installs, a series of resistors are installed
to generate a suitable 0-5V signal from the standard selector switches.

6.6.3.7 Paddle Shifter

 

Enable input: Enables paddle-shifting and selects the 'enable' input switch.

Active high/low: Selects polarity of paddle enable switch.

Output: Selects paddle output, typically this is for the horn.

Paddle input: Selects analogue input for paddle shifter.

Voltage for UP: Voltage on paddle input to indicate an up-shift.

Voltage for DOWN: Voltage on paddle input to indicate an down-shift.

Voltage for OUT: Voltage on paddle input to indicate that the output (horn) should be operated.

This expects you to pick an analogue input and have a resistor network on the up/down/horn switches to give 
three distinct voltages.
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6.6.4 Shift Curves

The shift curves are the main settings for controlling how the transmission behaves and when gear shifts occur. 
There is a curve for each gear except top. The curve can be adjusted by dragging the dots or by clicking on the 
[...] in the top right, the data table open up as shown.

  

In the above screenshot at 64% load, the transmission will upshift (change from 2nd to 3rd) if the speed 
exceeds 60MPH or downshift (change from 2nd to 1st) if it drops below 26mph.

The green dot shows the current load (40%) and speed (30mph.) At this 40% load, the upshift speed would be 
41mph and the downshift speed would be 17mph.

The layout of these curves has changed in firmware version 1.1 to show the up or down targets from within one 
gear. i.e. what do you want to happen when in first gear or second gear etc.
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For the 1st gear shift curve shown above, when the dot is in the active area the transmission will stay in first 
gear. If the dot goes above the line (as shown) the trans will shift up to second.

For the 2nd gear shift curve shown above, when the dot is in the active area the transmission will stay in second
gear. If the dot goes above the line the trans will shift up to third. If the dot goes below the line the trans will shift 
down to second.

In the above two example curves note that at 46% load:

• 1st gear upshift speed is 23mph.

• 2nd gear downshift speed is 19mph (less)

It is correct that these overlap. Say you are accelerating steadily at 46% load and the speed goes 
20,21,22,23,24mph. When the speed is above 23mph, the dot goes above the 1st gear shift curve line and tells 
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the trans to shift into 2nd. Now in 2nd the dot lands in the active area between the lines.

If by mistake the 2nd gear downshift line at 46% was set to say 26mph, after the 1->2 shift was completed, the 
dot would be below the 2nd gear downshift line and the trans would shift from 2nd back into 1st and then the 
cycle would repeat - very annoying!

Make sure the shift curve in the next gear overlaps to avoid a cycle of up and down shifting.

6.6.4.1 Shift Curves (display only)

In addition to the main shift curves described in the previous section, there are also "display only" curves - these
allow you to compare the up/down curves for a shift point (e.g. upshift 1-2 and downshift 2-1) on the same 
screen. As previously mentioned it is important that the "up" curve is always above the "down" curve to prevent 
cycling.

6.6.5 Line Pressure

The Line Pressure curves control the pressure solenoid in the transmission which influences shift speed, holding
power and shift harshness.

Depending on the option selected in the base settings, you can use either a single line pressure curve 
(recommended) or an individual curve for each gear.

0% is least line pressure, 100% is max line pressure. (Conversion to solenoid duty for transmission is handled 
internally.)

6.6.5.1 Line Pressure (Common)

 

6.6.5.2 Backfill solenoid PWM

For A340/A341 transmissions, a mapped table of PWM duties is used for the backfill solenoid. (This table is only
visible with A341 is selected.)

PWM duty cycle of output for backfill solenoid. Note that for A34x transmissions this is fixed at 300Hz and has 
an adjustability of approx +/- 4%.  (i.e. the PWM duty works in steps of  about 4%.) Higher duty gives lower 
backfill pressure.
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6.6.6 Test Mode

This menu gives access to test facilities.

6.6.6.1 Test Mode

 

This allows direct control over the gear selected and solenoid output duties. It should only be used with the car 
on stands for transmission testing purpose.

 Do not use on a moving vehicle - risk of injury!

Test Mode Controls

The "Enable Test Mode" and "Disable Test Mode" buttons are a master enable/diable for testing.
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Gear Selection

Clicking on a gear number will force selection of that gear. (The output solenoids will be set to the pre-
programmed pattern.)

Line Pressure

This allows you to override the line pressure curve and test out different pressure solenoid duties. The entry 
here matches the pressure curves where 0% is minimum pressure and 100% is maximum pressure.

(For GM transmissions the output duty is actually the opposite, this conversion is handled internally.)

Lockup

This allows you to override the lockup output and test out different solenoid duties.

3-2 / backfill solenoid

Some of the supported transmissions PWM the 3-2 / backfill solenoid. This allows that to be tested.
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6.7 Data Logging Menu
The Data Logging Menu allows you to:

• Stop and Start logging data from your TCU;

• View your saved log files using the accompanying MegaLogViewer software.

6.7.1 Start Logging

Clicking Data Logging > Start will display the Start New Data Log screen as shown below:

  

This will prompt you to save a new TunerStudio .msl file which will contain the data that is logged from your 
Megasquirt. By default this file will be saved in the DataLogs directory within the current project directory, 
although you can choose to browse and save it elsewhere if you prefer. As soon as you click “Save” the 
software will start to log data from your Megasquirt into this new file.

When data logging is running the “Data Logging” indicator label at the bottom of the gauge cluster will 
turn green.

6.7.2 Stop

Data Logging > Stop will cease data logging and the collated data file selected in the above section will be 
closed. Your data is now ready to be reviewed using MegaLogViewer.

At this stage the “Data Logging” indicator label at the bottom of the gauge cluster will return to its usual 
color. 

6.7.3 Logging Profiles

Data Logging > Logging Profiles is a feature of the Upgrade version of the software which allows customization 
of the data collected. The standard format used for data logging will be sufficient to analyze the data collected 
from your Megasquirt.

6.7.4 Automatic Logging

Data Logging > Automatic Logging is also another Upgrade feature and is not documented in this guide.
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6.7.5 Import / Conversion

The “Import / Conversion” options allow data to be be imported from two other sources, but is not covered here.

6.7.6 View with MegaLogViewer

MegaLogViewer is an analysis application which accompanies TunerStudio, and for which a license is included 
along with your Megasquirt. MegaLogViewer needs to be installed for this option to work.

MegaLogViewer can be downloaded from: http://www.tunerstudio.com/index.php/downloads.

Complete documentation of MegaLogViewer falls outside the scope of this guide, although the key 
datalog fields that are relevant to your Megasquirt are documented in Section 6.7.7.

Clicking Data Logging > Import / Conversion > View with MegaLogViewer will display the Open Log File screen 
as shown below:

  

Selecting the data log file that you want to view and clicking “Open” will start MegaLogViewer with the data from 
your log file loaded in. A sample of the main MegaLogViewer screen is shown below:
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From this screen you can review many of the sensor outputs and other readings from your Megasquirt. The 
“Quick View” graphs are especially useful and are easily customized using the options on the left hand side of 
the screen.

6.7.7 Transmission Control MegaLogViewer Datalog Fields

Below are listed the main datalog fields for MegaLogViewer.

ADC0-7

These are the raw ADC counts on the analogue inputs. May be useful during initial setup to confirm that the 
sensor inputs are working correctly.

CLT

The engine coolant temperature.

Convertor Slip

Where input shaft speed is available, this is a calculation comparing engine RPM to input shaft RPM.

EPC%

The percentage line pressure.

Gear

Currently selected gear.

gearselin

Raw bitfield of selector input signals active status. (i.e. an active low input shows as 1 when grounded.)

128 64 32 16 8 4 2 1

- - - - Switch P Switch A Switch B Switch C

Input RPM
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The input shaft RPM speed, if the transmission is fitted with that sensor. (e.g. 4L80E)

MAP

The engine manifold pressure.

Output RPM

The output shaft RPM speed. Either directly measured or back-calculated from wheel speed.

RPM

Engine RPM.

Seconds

Number of seconds that the TCU has been switched on.

Selector

Current gear selector position.

Sol 3-2 %

PWM duty cycle applied to the 3-2 or backfill solenoid (if fitted.)

SolStat

A bitfield representing the solenoid outputs.

128 64 32 16 8 4 2 1

- - Sol D Sol C / 3-2
> 50%

TCC > 50% EPC > 50% Sol B Sol A

Status1

A status bitfield.

128 64 32 16 8 4 2 1

OD cancel Lockup Race mode Brake - Config error Lost data Need burn

TCC%

The duty cycle applied to the torque convertor lockup clutch.

Time

Elapsed time in datalog.

TPS

Engine throttle position percentage.

Transmission Slip

Compares output shaft RPM with input shaft RPM. Could indicate slipping clutches. Will be undefined during a 
gear-shift.

Trans temp

Transmission temperature.

VSS 1

Vehicle speed.

(c) 2014-20 James Murray 2020-10-07 Page 66/74



Trans control setting up and hardware

7 ECU integration
The transmission controller can be used standalone, but will frequently be used in conjunction with a main 
Megasquirt ECU that runs the engine.

7.1 Collecting data from Megasquirt ECU
This is the recommended configution - it uses common data, reduces wiring and frees up some connections on 
the transmission controller for spare purposes.

The CANbus must be connected between the trans controller and the Megasquirt ECU. See section 3.3.7.

 

7.2 Sharing data to Megasquirt ECU
The Megasquirt-3 has provision for wheel speed and current gear. These can be collected from the transmission
controller over CAN. Configuration is at the Megasquirt-3 end.

Vehicle Speed Sensor 1

VSS input type = Digital

Digital input = CAN VSS

Scaler% = 100%

Gear Detection

Method = CAN Gear #

(c) 2014-20 James Murray 2020-10-07 Page 67/74



Trans control setting up and hardware

  

Mode = Poll

Remote CAN ID = 7

Remote CAN Table = 7

VSS 1 Offset = 4

Data Size = 16bit

Gear # offset = 15

The VSS and gear data can then be used within the Megasquirt-3 for datalogging to the internal SDcard, to the 
laptop or for features such as boost vs. gear etc.

7.3 Other ECU or dash integration
At this time, the CAN messages are Megasquirt specific. Future releases may support 11bit broadcast 
messaging. If you have additional applications in mind, please send an email to contact@megasquirt.co.uk to 
discuss.
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8 Appendix D: Text-based firmware loader
In most circumstances it is preferable to use the firmware loader included within the TunerStudio software. 
However, there is also a text-based firmware loader available. In older firmware releases this was included 
within the firmware zipfile, in future releases it may be available as its own download only.

The following documents how to use the firmware loader. The general operation is covered first under the 
Windows operating system, then Linux and Mac differences are noted.

Before attempting to load firmware, be sure to install any necessary serial drivers.

The following screenshots and examples show the loading of MS2/Extra firmware. The process is the 
same for the transmission control firmware.

8.1 Windows / general
i. Download the latest firmware zip file from the MSEXTRA.COM Downloads page. Save if prompted. Your web 
browser will most likely save that to a Downloads folder.

ii. Use My Computer / Windows Explorer and browse to this folder.

 

You are looking for a file similar to trans-release-1.0.zip  (If you don't see the ".zip" on the end, check your 
folder options and make sure the hide extensions is NOT ticked.) 
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iii. Right click on the file you saved and choose Extract All.

iv. The defaults are OK, and just click Extract. (Note that Windows adds a second level of directory when 
extracting.)

v. You should now find the files have been extracted. Open up the folders until you see this:

 

vi. Connect your serial cables and power on your ECU.

vii. If your engine has been running already, you must use "Save Tune As" in TunerStudio to save your existing 
tune settings before running the firmware loader.

viii. Exit your tuning software and ensure nothing is using the serial port.
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ix. Double click on ms2loader_win32.exe (If you get a security warning, click Run.)

The loader is text based. Answer all of the questions by pressing the required key on your keyboard. 

Example: 

MegaSquirt-2 Firmware Loader 3.22 2012-07-02 
. 
Remove the fuse powering your ignition coils. 
(Spark outputs may be undefined until you re-load your settings.) 
Press enter to continue... 
. 
Ensure that your Megasquirt/Microsquirt/ECU is 
-connected to your computer 
-has fused 12V power connected. 
Press enter to continue... 
. 
Ensure that no tuning software is running. 
Be sure to Quit the software, not just minimise it.. 
Press enter to continue... 
. 
Debug message Level: 
1: Normal 
2: More detail 
3: + serial comms 
4: + the s19 file as parsed 
Selection (default: 1): 
. 
Do you want to scan your serial ports automatically? (y/n default y) 
. 
COM1 MS2/Extra detected 
. 
Do you want to use COM1 (y/n default = y) 
. 
. 
. 
Found firmware files : ms2_extra_us.s19 : ms2_extra.s19 
. 
1: Megasquirt 2. 
2: Microsquirt, Microsquirt module, DIYPNP, MSPNP2. 
. 
. 
File to upload (1, 2, filename, default= ms2_extra.s19): 1 
. 
Preserve sensor calibrations (only for MS2/Extra) (y/n, default: y)? 
. 
======================================================== 
Settings selected: 
Serial port: COM1 
S19 File: ms2_extra.s19 
Debug level: 1 
Jumperless reflash enabled 
Preserving sensors calibrations 
======================================================== 
Press enter to continue... 
Sending jumperless flash command 
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Attempting Wakeup... 
Fetching : sensor calibrations 
Erasing main flash! 
Erased. 
Sending firmware to controller... 
[========================================================>]100.0% 
Sending : sensor calibrations 
Wrote 105052 bytes 
*** Settings not preserved. Please re-load your MSQ / tuning settings *** 
Press enter to continue... 
.

If this takes longer than a minute then you likely need to adjust the port settings of your USB-serial adapter to 
reduce the latency setting.

The first time you install firmware on an MS2 or Microsquirt-module it might be necessary to use the boot 
jumper. On a Microsquirt the equivalent is to ground the BOOTLOAD wire.

  

MS2 in normal condition without boot jumper.

Installing the boot jumper.

MS2 with boot jumper in place.

8.2 Mac / Linux
Mac OS X and Linux users need to run the firmware loader from the command line. The exact procedure varies 
by release and with the tools you have installed. The loader needs to be run from the directory containing the 
firmware files.

Depending on distribution you may be able to "open in terminal" or "open here" to launch a terminal in the 
correct directory, otherwise open a text terminal and use 'cd' to change directory to the correct place. Then 
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./ms2loader_XXXX as appropriate. Note that you MUST use the keyboard, put the mouse to one side.

Then step through the firmware loading process as described above.

8.3 Steps after loading firmware
Having loaded the new firmware, read any included RELEASE-NOTES.txt and README.txt .

Open up TunerStudio and update your project "ini" file when prompted. If TunerStudio is unable to find or 
download the correct file, it is always included within the firmware zip that your extracted, so browse there and 
pick the correct file that matches your ECU variant.

Load in the tune your previously saved and review any warnings.

Check that sensor inputs look sensible and re-calibrate your temperature sensors if necessary.
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9 Revision history
2014-09-05 Started.

2014-10-23 Re-do wiring tables, add GPIO, MS2. Add most content.

2014-11-19 Add comparison table.

2014-12-10 Update user interface for 0024.

2014-12-12 Update user interface for 0025. Add ECU integration section.

2014-12-26 Updated CAN wiring diagrams.

2014-12-27 Add more trans specific notes. Add LUF.

2014-12-30 More notes and diagrams about speed sensor inputs.

2014-12-31 OD cancel. Add datalog fields section.

2015-01-11 Updates for 0028

2015-01-20 RPM upshift note for 0029.

2015-02-01 LUF/sol D note.

2015-02-13 MS2 SelD pin change.

2015-03-11 Broke out Microsquirt V1, V2, MS2, GPIO hardware into supplement manual. Added PDF
bookmarks/anchors. Updated lockup screenshot.

2015-03-24 Updates ref VR2+/- and ISS.

2015-03-25 Tweaks. Fix MAP sensor diagram.

2015-08-06 Added input/output truth tables. Added section for combination TunerStudio projects.

2016-01-26 Add DRS pin names for 4R70W. Add selector in diagram to A340.

2018-07-03 Add diode on EPC

2018-07-08 Split to new version for 1.1. Re-do settings pages from latest beta. Add TS loader. 
Rework initial setup and serial comms. Add gearselin column to selector tables.

2018-09-19 Add detail for log fields: gearselin, solstat, status1. Add customer supplied A340 input
schematic.

2018-11-23 Update shift curves information for new style of curves.

2020-10-06 Add section for display-only shift curves.
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